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Introduction to InfoTree
InfoTree provides for the storage and retrieval of "freeform" notes.    Notes can be 
added, updated and/or deleted within one or more Notes Databases. 

Each note record has a title.    This title is displayed on the main screen of InfoTree
so that you can browse for your records. Records may also be found by searching 
for text strings within the note text and/or title. You can also define 
keywords/keyphrases and link them with records for later searching and retrieval. 
Records can also have document files (word processor documents, spreadsheets, 
etc.) associated with them.

There are two levels of records ... Folders and Notes ... thus allowing for a 
structured view of your information. 

The remaining topics    will guide you through the features and benefits of 
InfoTree.



InfoTree's Main Screen

InfoTree uses one major screen to provide you with its functionality ...

The Tree View ...    this is the default view you see when InfoTree starts.    This screen
provides you with the structured view of your folders and notes.    From here you 
add new folders and/or notes.    You can also browse your records and access them
by clicking on a note title.    This view also contains an 'Editor' window within 
which you can view the contents of any selected Folder/Note.    You can edit the 
text within the 'Editor' window and save your edits on the database.    There is 
also a print button to produce a hard copy of the contents of the 'Editor' window.

The Full Search View ... this view is used to perform searches in the notes database.    You 
can perform 'text string' searches,    keyword/keyphrase searches and title browses.    The 
results of your search (Folder/Note titles) are listed for your review.    You can also browse 
these records and access them by clicking on the Folder/Note title.    The search 
view also contains an 'Editor' window discussed above.



InfoTree's Other Screens
InfoTree also uses several minor screens to complete its functionality ...

Text String Search Screen: 
initiates text string searches from within other InfoTree screens.

Keyword/Keyphrase Search Screen: 
initiates keyvalue searches from within InfoTree's    Search Screen.

Keyword/Keyphrase Creation/Selection Screen: 
used to define your keyvalues and assign them to specific notes.

Document Association Screen: 
used to associate documents and their required    processors to specific 
notes.

Print Parameters Screen: 
used to specify pages layout and print ranges.

New Notes Database Screen: 
used to define the location and identification of a new database .

Open Notes Database Screen: 
used to view a list of available Notes Databases and select the one to which
you wish to switch.



Typical Applications of InfoTree
InfoTree lends itself to many uses ... here are some examples.

Freeform information storage and retrieval ...

Recipes
Home inventory
Projects
Knowledge Base

Front end to existing documents ...

Document manager for DOS files
Research
Legal Library

Combinations ...

Consulting engagements
Court cases
Software development and support



Creating Folders and Notes
The creation of Folders and Notes is initiated on InfoTree's Main Screen.

After positioning yourself in the Tree , simply click on the appropriate button 
(Create New Folder or Create New Note) to invoke the creation process.    InfoTree 
will then present you with a panel to enter the title of the Folder/Note.    After 
entry of the title you will be positioned in the Editor so that you can immediately 
enter the text for the new Folder/Note.

While entering the text for the Folder/Note, you can use all of the features of the 
Editor (i.e., fonts, bold, italic, underline, strikethru, color and paragraph 
alignment).

You can also immediately define and/or select keywords/keyphrases to be linked 
to this new Folder/Note.

InfoTree allows you to define your own keyvalues and use them to tag the note 
record for later retrieval.    These keywords/keyphrases are automatically stored in
a database for you.

The keyvalues to linked to each note record can be created new or selected from 
the database of previously defined keyvalues.

You can link any number of keyvalues to each note record.

See the Topic:      Key Search 

You may also choose to immediately associate this Folder/Note with existing 
documents.

InfoTree allows you to browse you system/network for existing documents (word 
processor files, spreadsheets, etc.) and associate them with your note record.    
InfoTree also stores the name and location of the document processor required to 
access the document within its database.    You provide a description for this 
association that InfoTree uses to allow you to activate the document at a later 
time. 

See the topic Associating Documents With Your Folders and Notes .



Creating and Linking Keywords/Keyphrases
InfoTree allows you to define your own keyvalues and use them to tag the note 
record for later retrieval.    These keywords/keyphrases are automatically stored in
a database for you.

The keyvalues to linked to each note record can be created new or selected from 
the database of previously defined keyvalues.

You can link any number of keyvalues to each note record.

(See the Topic:      Key Search )



Using InfoTree's Built-In Text Editor
InfoTree has a built-in Editor which can be accessed from within its main screen.

You can control the following items relative to the text entered for each note.

Fonts: ...    select font name, style and size.

Style ...    Bold,Italics,StrikeThru,Underline.

Colors ...    set selected text to one of sixteen (16) colors.

Paragraph alignment ... align selected paragraph left, right, center and left/right 
justified.

Copy, Cut, Paste ...      copy selected text to the clipboard, cut selected text from 
the note, and paste text from the clipboard to the    current cursor position.

Find, FindNext, Replace ... finds first/next occurrence of a text string and/or 
replaces the found string with a new string.

You activate these functions by selecting from the Editor Menu.    You can also 
activate many of these functions using tabs available within the Editor.    The 
Editor screen must be in its expanded mode to provide access to these tabs.    
Double clicking within the Editor text area invokes the expanded mode ... the [F6]
key can also be used to expand/collapse the Editor text area.



Fonts
InfoTree allows you to select any portion of your text and then choose any of the 
fonts provided by your system.

A complete dialog box is displayed so that you can specify the font name, style 
and size,    and color .    These font choices are stored with the text and are 
accurately reflected in printouts .



Character Styles
InfoTree allows you to select any portion of your text and then choose any of the 
text highlights        .... Bold,            Italics,          StrikeThru        and        Underline.

These highlights are also selected while in the Fonts dialog box.

These highlights are stored with the text and are accurately reflected in printouts
.



Font Colors
InfoTree provides for the following sixteen (16) colors for fonts.

Black Maroon
Green Olive
Navy Purple
Teal Gray

                        Silver                              Red
                        Lime                                Yellow
                        Blue                                  Fuchsia
                        Aqua                                White
                                    



Paragraph Alignment
InfoTree allows you to control the alignment of each individual paragraph of text.

Paragraphs can be aligned LEFT

Paragraphs can be aligned RIGHT

Paragraphs can be    CENTERED

Paragraphs can also be justified on the left and right to provide blocking.

InfoTree also allows you to move your left and right margins in or out and you can
also increase or decrease line spacing within individual paragraphs.



Copy, Cut and Paste
InfoTree allows you to take advantage of the Windows Clipboard.

Copy ...
You can select portions (or all) of your text and then copy it to the windows 
clipboard.    

Cut ...
In addition to copying the selected text and its specifications to the clipboard, Cut
also removes the selected text from your information.

Paste ...
Places clipboard text in your information at the current cursor position.



Find, FindNext and Replace
InfoTree allows you to search for and/or replace text strings within your notes 
details.

Find searches for the first occurrence of your specified string, starting from the 
top of your notes details.

Find Next searches for the next occurrence of your specified string, starting from 
the position of the last occurrence.

Replace searches for the first occurrence of your specified string, starting from 
the top of your notes details.    If and when the string is found you are allowed to 
confirm the replacement of the found string with the replacement string you 
specified.    You can also choose to skip this occurrence.    InfoTree then moves on 
to the next occurrence of the search string and allows you to replace or skip it.    
This continues until all occurrences are found or until you cancel out of the 
replace activity.



Searching for Folders and Notes
InfoTree offer three major ways to search for your Folders and/or Notes records.

Text Search ....

Keyword/Keyphrase Search ...

Browse ...

Each of these topics are covered in detail ... see the appropriate topic !



Text Search
InfoTree allows you to search for text strings within your notes titles and/or 
details.

The text search capability can be initiated while in InfoTree's Main Screen 
searching the tree structure or by using the Full Search feature to search the 
entire database.    You can search titles only, text only or both.

If you search using the Tree structure, InfoTree will position you, within the Tree, 
at the title of the first    record that satisfies the search.    You can search the 
entire Tree or choose to limit your search to just one branch of the Tree.

If you are using the Full Search capability, InfoTree will display the titles of all 
records that satisfy the text search.    



Key Search
While you are using the Full Search capability , you can initiate a Key Search.

The Keyword/Keyphrase Search Screen will allow you to structure a search of the 
entire notes database using the keyvalues that were linked to your notes records.

You can build a list of keyvalues that COULD BE linked to notes.    These are 
handled as follows ... a note record that is linked to ANY of these keyvalues will 
satisfy the search.

You can build a list of keyvalues that MUST BE linked to notes.    These are handled
as follows ... a note record that is linked to ALL of these keyvalues will satisfy the 
search.

You can also used both lists. In this case, a note record has to satisfy the MUST BE
condition before it can be considered for the COULD BE condition.



Browse
InfoTree allows you to browse your records by clicking on their titles.

The text browse capability can be initiated while in InfoTree's Main Screen or 
while in InfoTree's Full Search Screen.    Browsing is a manual, eye-sight activity.

In the Tree View, you can use your mouse and/or keystrokes to navigate the 
structured view of your note titles.    You can expand/collapse the structured view 
to expose/hide additional folders and note titles.

Using the Full Search capability, you click on the Title Browse button and all 
record titles are loaded into a list box for your browsing.    This list is sorted by 
title.    Each record displays an ICON to indicate that the record is either a Folder 
or Note.

The contents of any selected Folder/Note will be displayed with the Editor section 
of the screen.



Printing and Other Special Functions
InfoTree provides full printing capabilities.

You have control over the page layout and other print parameters.

InfoTree also provides many Special Functions that allow you to maintain your 
notes database(s) and its structured view (Tree).

                          Viewing The Contents of Your Folders and Notes 
                          Printing The Contents of Your Folders and Notes 
                          Updating Your Folders and Notes 
                          Deleting Your Folders and Notes 
                          Moving Folders and Notes 
                          Reversing Folders and Notes Designations 
                          Associating Documents With Your Folders and Notes 
                          Activating Associated Documents 

                          Configuring InfoTree's Main Screen 
                          Configuring InfoTree's Text Editor 
                          Configuring Your Tree-Database Organization Logic 

                          Creating Additional Notes Databases 
                          Opening (Switching To) Other Notes Databases 
                          Exporting and Importing Notes Between InfoTree Databases 
                          Implementing Shared (Networked) Access 
                          Backup/Restore Your Database 
                          Synchronization of Your Tree-Database 



Printing The Contents of Your Folders and Notes
InfoTree provides for very flexible printing of your Folders/Notes text.

Printing is initiated from InfoTree's main screen.    Simply click on the Print 
Folder/Note Text button or use the File Menu to access the printing functionality.

InfoTree allows you to specify printing options and page layout parameters.    This 
is initiated under the File Menu.



Updating your Folders and Notes
InfoTree allows you to update, edit and add-on to the contents of the text 
associated with any of your Folders and/or Notes.

Single click on the Folder/Note of your choice (in the structured view or in the list 
resulting from a search) and    InfoTree will then display the contents in the Editor 
section of the screen.    This allows you to view and/or make extensive changes to 
the contents. You can also print the contents at this point.    You can also add 
and/or delete keys to the folder/note. You can also associate existing documents 
with the folder/note.

After your changes have been made, you should click on the Save Edits button.    
This will store your edits in the database.    If you forget to do this, InfoTree will 
prompt you and ask if you wish to save your edits.



Deleting Folders and Notes
InfoTree allows you to delete any of your Folders and/or Notes.

Folders and/or Notes can be deleted only from the Main Screen .

Simply click on the title of the Folder/Note within the Tree and then press the 
[Delete] key.



Moving Folders and Notes
From time to time, you may wish to move Folders and/or Notes records within 
InfoTree's structured view (Tree).

A movement is initiated from the Main Screen .    Select Move Folder/Note from the
Tree Menu and InfoTree will display a panel with more instructions.    Now click on 
the Folder, under which you wish to move the previously selected Folder/Note, 
and then click on the [ Move ] button.

A shortcut method is also available.    Click on the item to be moved and then click
it again with the [Right] mouse button.    This initiates the move operation.    Now 
click ( [Left] mouse button ) on the Folder under which you wish to move the 
selected item.    This combination of [Right] and [Left] mouse buttons provides for 
a fast, efficient MOVE operation.



Reversing Folders and Notes Designations
InfoTree allows you to reverse the designation of Folders and Notes.

Folders can be changed to Notes ... and ... Notes can be changed to Folders.

This function is initiated from within the Main Screen by choosing Reverse under 
the Tree Menu.

Note: Folders must be empty in order to be reversed.



Associating Documents With Your Folders and Notes
InfoTree allows you to associate existing document files with any of your 
Folders/Notes Records.

This association is initiated by clicking on the [Associated Docs.] button in 
InfoTree's main screen.    InfoTree then displays a panel within which it lists (if 
any) the documents that are associated with the selected note.    To add and/or 
modify an association, click on the appropriate button within this panel. 

InfoTree will then display a screen that allows you to identify the associated 
document with a string of text and specify the exact document file name and 
location.    You also specify an existing program (document processor) on your 
system that will be used to activate the document.    You can use the Browse [ ... ] 
feature to locate the document file and its processor.      InfoTree tries to provide 
you with the appropriate document processor based on the file type.    You can 
also override this information as you desire.

Documents can be word processor files, spreadsheet files or any other file to be 
processed.



Activating Associated Documents
InfoTree allows you to select an associated document and activate its required 
processor (the program that you use to work on the document).

While you are in InfoTree's main screen, simply click on the [Associated Docs.] 
button.    InfoTree will then display a panel within which it lists (in any) the 
documents that are associated with the selected note.

Simply double click on the desired document within this list and InfoTree will 
activate it for you.



Creating Additional Notes Databases
InfoTree allows you to create and maintain any number of Notes Databases!

Each Notes Database resides in a separate DOS directory.    The introductory 
information, including this text, is within a Notes Database within the DOS 
directory in which you installed InfoTree.

You can create additional databases under other DOS directories. Select New 
Database under the File Menu on the Main Screen .    InfoTree will display the New 
Notes Database Screen that will coach you through the database creation 
process.    After the creation of the database, InfoTree will automatically switch 
you to the newly created (empty) database and you can begin work.



Opening (Switching to) Other Notes Databases
InfoTree provides an easy vehicle whereby you can switch from your currently 
open notes database to any of your other notes databases.

InfoTree creates and maintains tabs (below the Tree/Editor in the main screen) 
that identify each of the databases you have defined.    Simply click on the tab of 
your choice to switch to that database.



Implementing Shared (Networked) Access
InfoTree provides for the use of passwords to help you implement shared 
(networked) access to your database(s).

Four levels of access are provided:

Exclusive Access
provides private access so that you can perform critical functions such as 
backup/restore and password maintenance.

Modify Access
provides access to all of the information creation functions concurrent with 
other users at this or lower levels of access.    Content and/or the structure 
of the database may be changed.

Update Access
allows access to the text of your notes concurrent with other users at this 
or other levels of access.    Content may be changed; however, the structure 
of the database cannot.

Read Only Access
allows viewing access to the text of your notes concurrent with other users.

You must supply a password for each of these access levels.      While passwords 
are present, one's access to the database is determined by the password supplied
at the time the database is opened.    If no valid password is supplied, access is 
denied.

To enable shared (networked) access click on Enable under Shared Access under 
Options under the File Menu.    This enables the Password menu option which 
allows you to create and/or maintain your access level passwords.



Backup and Restore Your Database
InfoTree provides a feature for backing up your database to a floppy diskette 
and/or another DOS directory on your system disk.    Multiple diskette backups are
supported **

InfoTree also provides a feature that allows you to restore your database from a 
floppy diskette and/or another DOS directory on your system disk.    Multiple 
diskette restores are supported **

These features are initiated by selecting Backup and/or Restore under the File 
Menu.

These also allow for quick movement of a database to and/or from your system to 
another system.

**NOTE:
InfoTree implements its Backup and Restore functions by performing DOS 
"copyfile" commands.    An InfoTree database actually consists of twelve (12) DOS 
files which must be individually copied to/from the backup location.    These twelve
files are ...

INFO.ISD Actual individual notes records (data portion)
INFO.ISF Actual individual notes records (finder file for keyed access)
INFO.ISM Actual individual notes records (file structure information)

KEYS.ISD Actual keywords/keyphrase records (data portion)
KEYS.ISF Actual keywords/keyphrase records (finder file for keyed 
access)
KEYS.ISM Actual keywords/keyphrase records (file structure information)

INFOKEYS.ISD Notes/Keys cross reference records (data portion)
INFOKEYS.ISF Notes/Keys cross reference records (finder file for keyed 
access)
INFOKEYS.ISM Notes/Keys cross reference records (file structure information)

INFODOCS.ISD Notes/Associated Document records (data portion)
INFODOCS.ISF Notes/Associated Document records (finder file for keyed
access)
INFODOCS.ISM Notes/Associated Document records (file structure 
information).

As InfoTree copies these files to your desired backup location (DOS directory/sub-
directory) on a floppy diskette, it will automatically deal with a "Disk Full" 
condition and prompt you to insert another diskette to complete the backup 
operation.    Please understand; however, that since InfoTree uses DOS "copyfile" 
commands to move the files, each of the files must fit within the space available 
on a single diskette.



Configuring Your Main Screen and Structured View
You can configure your structured view of InfoTree Folders and Notes as follows:

* Specify your desired background color.

The background for the structured view can be changed to the color of your 
choice. Your latest background color choice is saved on your system disk and 
restored each time InfoTree is started.

* Specify your desired font including the style and size.

The descriptive text in your structured view can be changed to any font presently 
on your system.    Your latest font specifications are saved on your system disk 
and restored each time InfoTree is started.

These functions are available under the Options menu under the File Menu on the 
Main Screen.

You can change the main screen configuration as follows:

* Specify screen size and location.

By using your mouse, you can drag the screen boundaries to create the size 
screen you desire.    You can also drag the screen's title bar to change the screen's
location.    This allows you to best utilize your monitor's image space.    Your latest 
screen size and location is saved on your system disk and restored each time 
InfoTree is started.

                



Viewing The Contents of Your Folders and Notes
InfoTree inherently displays the contents of Folders and/or Notes as you access 
the records within the database.    On the main screen, InfoTree provides an Editor
section within which it displays the contents of the selected Folder/Note record.



Editor Section of InfoTree's Main Screen
InfoTree inherently displays the contents of Folders and/or Notes within the Editor
section of its main screen. 

The 'Editor Section' is actually a part of the Main Screen and/or Search Results 
Screen of InfoTree.    This part of the screen can be sized by sliding the "Splitter 
Bar" left or right.    The "Splitter Bar" is a vertical bar between the Tree and the 
Editor Section.    Thus, you can balance the use of the screen real estate for use by
the Tree and your Editor Section.

You can also configure the Editor Section to best suit you needs.    You can set a 
default font to be used by the Editor (i.e., name, size, color, style, etc.).    You can 
also choose a background color for the Editor Section of the screen.    These 
choices are stored by InfoTree and used when the program is restarted.

These functions are available under the Options menu under the File Menu on the 
Main Screen.

While you are in the Editor Section, you can make full use of InfoTree's text editor 
to update the contents of the selected folder/note.



Synchronization of your Structured View and your Notes Database
InfoTree maintains the synchronization of your Tree and your Notes Database. 
This synchronization is required to ensure that your database can be used to 
correctly rebuild your structured view.

InfoTree always performs this synchronization when the data base is closed 
(provided there were structural changes made to the Tree).    

In addition, InfoTree will perform this synchronization automatically after every 
'N' changes to the Tree.    You can set the value of 'N' using the Synchronization 
option under the File menu.    Setting this value to zero (0) instructs InfoTree to 
wait until database closure to perform the synchronization.



Exporting and Importing Notes Between InfoTree Databases
InfoTree allows you to export note records from its current database to an 
intermediate file anywhere on your system and/or network.    This file is 
specifically formatted by InfoTree and should not be accessed by other software 
tools.    InfoTree allows you to browse your system/network to specify the location 
and name of the target file.    If you choose an existing file, it will be overwritten.

You can export any folder and/or note from the current database to this 
intermediate file.    If your choose a folder that contains other folders and/or 
notes, InfoTree will ask you to confirm that it should export all of these records.

InfoTree also allows you to import the records from this intermediate file into its 
current database (switch to the target database).    First, you must click on the 
Folder under which you wish to add the records and then initiate the import.    
InfoTree will allow you to browse your system/network for the file containing the 
records to be imported.

Export/Import functionality is found under the Tree Menu.



Configuring Your Tree-Database Organization Logic
InfoTree allows you to create and maintain a Tree representation of your notes 
database.    The Folders/Notes added to this Tree are placed on the Tree 
chronologically; that is, each Folder is added to the bottom of the Tree and each 
Note is added at the bottom of the Folder into which it is being placed.    

This chronological positioning is the default organization technique for InfoTree; 
however, you can specify other organization techniques.

Sorted Alphabetically by Title ...
You can specify that Folders and Notes be added to the tree in sorted order 
according to their title; thus, Folders are placed on the Tree in alphabetical order 
by title and Notes are placed within Folders in alphabetical order by title.

Added Chronologically and Directed Moves ... 
You can also choose an organization technique called "Directed Moves".    In this 
technique Folders and Notes are added to the Tree chronologically; however, you 
may later move them to any position on the Tree.    Folders and Notes are actually 
inserted below the existing tree item of your choice.

To specify the logic of your choice, choose Current Database/Tree Organization    
under Options under the File menu.

This decision should be made before records are added to a new database.    If you
switch from non sorted tree logic to SORTED tree logic, only the records added 
and/or moved after this switch will be controlled by the SORT logic.



Licensing and Registration
Prospective customers are licensed to evaluate the fully-functional unregistered version of 
InfoTree for up to 21 days, for the purpose of deciding whether the program suits their 
needs.    At the end of this 21-day trial period, users must either cease using InfoTree or pay 
a    registration fee of $39.95 to iSBiSTER International Inc., for the right to continue using 
the program.    Use of an unregistered copy of InfoTree for more than 21 days, or use of a 
registered copy by any person or business other than the licensee, is prohibited and a 
violation of international copyright law.
 
Each "user" of InfoTree requires a license.    However, each user is entitled to use InfoTree on 
as many machines as he/she likes as long as it is for their use only.
 
InfoTree is Network Ready.    Each InfoTree "user" on the network requires their own license. 
 
Registration brings other benefits besides the legal right to continue using InfoTree.    First, 
you will receive a Security ID code that you may enter into the program which will eliminate 
the "registration reminder" screens that begin to appear after an unregistered copy has 
been used for more than 21 days.    Second, you will be entitled to free upgrades of the 
major version of    InfoTree you register as minor revisions are released.    Third, technical 
support is available for registered customers.

How to Register Your Copy of InfoTree
The registration fee for each copy of    InfoTree is $39.95 + $5.00 (shipping and handling) 
ONLY Residents of Texas must add the 8.25% State Sales Tax.    
 
For network quantities of 11 and up please call 214-495-6724 and ask for Sales.
 
Payment can be made by mail, by voice phone, FAX, or online.
 
By mail:    send cash, checks, or international money orders payable in U. S. funds and drawn
upon a U. S. bank.

iSBiSTER International, Inc.
1111 Beltline Road, Suite 204
Garland, Texas 75040
USA

 
Sorry, we do not accept foreign checks drawn on foreign banks.
 
 
By phone:    Visa,    MasterCard, American Express and Discover are accepted:    call 214-495-
6724
 
Online:    there are three ways to register    InfoTree online.
 
CompuServe subscribers can charge their InfoTree registration fees to their CompuServe 
statements.    Log on to CompuServe and GO SWREG.    When prompted for the SWREG ID, 
enter 49.    You will then be able to download the latest version of    InfoTree.    Your Security 
ID code will be sent to you via CompuServe mail when we receive notice of your order from 
CompuServe.    At this time SWREG only allows registration of the product.    If you wish to 
order optional items feel free to send us CIS mail with the information as specified in Email 
Orders below.
 



The iSBiSTER BBS (214-530-2762) will accept registrations by Visa, MasterCard,    American 
Express or Discover cards.
 
Internet or Other Email Orders
 
Please send the following information via Email to sales@isbister.com and we will be happy 
to process your order.
 
1.    Complete Name and Mailing Address.
2.    What you want to buy (inclusive of all options).
3.    Credit Card Number with Expiration 
            (We accept Visa, Mastercard, American Express or Discover)
4.    Any notes or special instructions you wish to accompany the order.
 
FAX:    You can fax to us at 214-530-6566 your orderfrm.wri along with your credit card 
information and we will ship the same day.    We cannot reply back by fax.
 
Disclaimer of Warranties
 
iSBiSTER INTERNATIONAL, Inc. does not warrant that    InfoTree software will meet your 
requirements or that the operation of the software will be uninterrupted or error free.    Nor 
do we offer any Warranties or Guarantees of any kind.    You are free to use InfoTree in any 
way you see fit,    but AT YOUR OWN RISK!
 
iSBiSTER INTERNATIONAL, Inc. is not responsible for any problems or damage caused by the 
software or that may result from using the software; whether licensed or not. This includes, 
but is not limited to, computer hardware, computer software, operating systems, and any 
computer or computing accessories. End user agrees to hold iSBiSTER INTERNATIONAL, Inc. 
and/or any persons associated with the creation of this software harmless for any problems 
arising from the use of the software.
 
We regret having to place such a disclaimer in a piece of software.    We    have made every 
effort to make this software product as efficient and accurate as possible; however, in a 
world full of frivolous and ridiculous law suits, we have no alternative.
 
WE HOPE YOU ENJOY THE SOFTWARE and we trust that you will find it productive!
 



Distribution Points for iSBiSTER Products:

iSBiSTER    BBS 
    Telephone Number      214-495-6724
    2 - 14,400 nodes and 1 - 9600 node,    F8N1,
    Full Duplex
    8 Data Bits
    1 Stop Bit
    NO PARITY
    Recommend Emulation      ANSI, also support TTY & VT100/102
    Recommend Download Protocol Zmodem. Others supported also.

NOTE:    This is a Wildcat 4.0 BBS (RIP Graphics are disabled).
 
CompuServe Information Service (CIS) 
WinShare forum
Keyword search on iSBiSTER 

America On Line (AOL) 
Goto the Software Center.    When you Search The Libraries check off All Dates and All 
Categories and use the Keyword iSBiSTER for your search parameter.

Internet 
We have made a homepage for iSBiSTER available to those with Web access.    Links to our 
ftp site allow for quick downloading of our latest releases.
 
The address (or url) for it is:    http://www.isbister.com/isbister

You can also download the latest release of our family of products via ftp with an anonymous
logon.

To ftp the files follow these simple steps

1.    ftp to ftp.isbister.com
2.    logon with anonymous
3.    password will be your local logon.    (Example:    user@yoursystem.com)
4.    Then cd/pub/isbister
5.    Tell your system you are about to do a binary transfer by typing    'binary'    and pressing 
enter.
6.    Then type get 'filename'.

This will transfer these files to your local space and it is a normal download from there on for
shell account users.

We have a 'readme.txt' file that will detail the contents of the archives.




